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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these 
consultants when you need help.  To determine if you have a consultant assigned to your division 
or college, look to: http://rohan.sdsu.edu/~facstaff 
 

Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to 
provide all students, faculty, and staff with "baseline" access to information resources via 
networks, training in the uses of baseline hardware and software systems, and ongoing 
professional and technical support for utilization of computer resources at San Diego State 
University.  You can access the BATS Web Page by pointing your browser to: 
http://rohan.sdsu.edu/~bats/ 
 

Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to 
answer your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

�

Help from the Faculty Computing Help Line  
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 



Microsoft Excel Intermediate 
Using formulas helps you analyze data on a worksheet. Creating charts 
provides another means of analyzing or representing data on a worksheet. 
You will learn how to utilize these two features in this workshop. 

 
The following topics will be covered… 

The Excel Screen......................................................................................... 1 
The Formula Bar ......................................................................................... 2 
Types of Operators ...................................................................................... 2 
Order of Precedence.................................................................................... 2 

What Error Values Mean......................................................................... 2 
Copying Formulas................................................................................... 3 

Using the AutoSum feature ......................................................................... 3 
Using the Function Wizard ......................................................................... 3 
Entering Functions ...................................................................................... 3 
Creating a Chart Using the ChartWizard .................................................... 4 
Plotting a Data Series in Rows or Columns ................................................ 4 
Plotting Nonadjacent Selections.................................................................. 4 
Changing the Chart Type ............................................................................ 4 
Adding Items to a Chart .............................................................................. 5 

Adding Data Labels............................................................................. 5 
Adding a Legend ................................................................................. 5 
Adding Gridlines................................................................................. 5 

Step-by-Step Instructions for In-Workshop Exercise ................................. 6 
Downloading Your Roster from the Registrar’s Office .............................. 6 
Text Import Wizard Box ............................................................................. 7 
Formatting your Imported Data................................................................... 8 
Congratulations! .......................................................................................... 9 
Shortcut Keys – Windows......................................................................... 10 
Shortcut Keys – Mac................................................................................. 10 
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The Excel Screen 
*Note that this is a picture of the MS-Excel98 for Mac screen. The MS-Excel 97 for 
Windows screen is slightly different. 
 

 

 

Worksheet Tab. This should be 
renamed to reflect your class section. 

The active 
cell's formula 
appears here. 

Auto Sum 
command. 

Auto Sort 
command. 

To select 
entire 
worksheet, 
click here. 

Percent 
Style. 

To adjust column 
width, drag or 
double click on 
the line between 
two columns. 

To adjust row 
width, drag or 
double click on 
the line between 
two rows. 

Chart 
Wizard. 

To put black 
borders around 
cells, click here 
for border 
options. 
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The Formula Bar 
When the formula bar is active, you can create a formula by typing, 
inserting functions, or selecting cells. Simply click in the data entry area 
and begin typing. Formulas always start with the = sign. 
 

 
 

Types of Operators 
You use operators to specify the kind of mathematical operation to 
perform on the elements of a formula. The common types of operators 
used in formulas are arithmetic operators and comparison operators. 
 
Arithmetic Operators 
These operators perform basic mathematical operations, combine numeric 
values, and produce results. 
 

+ Addition % Percent 
– Subtraction ^ Exponentiation 
/ Division  
* Multiplication  
 
Comparison Operators 
These operators compare two values and produce logical values of TRUE 
or FALSE with these operators. 
 

= Equal >= Greater than or equal to 
> Greater than <= Less than or equal to 
< Less than <> Not equal to 
 

Order of Precedence 
Most formula errors occur when the mathematical operators are not 
entered in the proper order of precedence. The following is the order of 
precedence for mathematical operations in a formula: 
 

*, / Multiplication, division 
+, - Addition, subtraction 

 
You can change the order of precedence by enclosing segments of the 
formula in parentheses. Excel first performs all operations within the 
parentheses and then performs the rest of the operation in the appropriate 
order.   
 

 Note that each open parenthesis must be matched by a closed parenthesis, 
or Excel will not accept the formula.   
 

What Error Values Mean 
Microsoft Excel displays an error value in a cell when it cannot calculate 
the formula properly. Error values always begin with a number sign (#). 
 
Error value Meaning       
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#DIV/0! Is trying to divide by zero. 
#N/A Refers to a value that is not available. 
#NAME? Uses a name that Excel doesn’t recognize. 
#NULL! Specifies an invalid intersection of two areas. 
#NUM! Uses a number incorrectly. 
#REF! Refers to a cell that is not valid. 
#VALUE! Uses an incorrect argument or operand. 
##### Produces a result that is too long to fit in the cell. This is not 
actually an error value, but an indicator that the column needs to be wider. 
 

Copying Formulas 
You may want to copy the same formula across a number of columns or 
down a number of rows.   
 
To Copy a Formula to Other Columns: 
1. Select the cell of the formula you want to copy. 
 

2. Drag the fill handle (bottom right corner of the cell) across the cells 
in which you want to copy the formula. 

 
Excel copies the formula to the other cells and, in each column, adjusts 
the formula’s references so that the formula refers to the numbers in that 
column. 
 
To Copy a Formula to Other Rows: 
1. Select the cell of the formula you want to copy. 
 

2. Drag the fill handle (bottom right corner of the cell) down through 
the cells in which you want to copy the formula. 

 
Using the AutoSum feature 

When you want to quickly add the values across a row or down a column, 
use the AutoSum button.   
 

Using the Function Wizard 
Whenever you want to use a built-in Microsoft Excel function or a custom 
function, your can use the Function Wizard  to help you select a function, 
assemble the arguments correctly, and insert the function into your 
formula. The formula bar shows the changes you make as you build your 
formula. 

 
Entering Functions 

Functions are predefined formulas. Excel provides more than 200 built-in 
functions that enable you to create formulas easily for a wide range of 
needs. Each function consists of the equal sign, and the function name. 
To enter a function in the active cell, type = (equal sign), followed by the 
function name (for example, SUM), followed by an open parenthesis. 
Then specify the cell or range of cells you want the function use, 
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followed by a closed parenthesis. When you press Enter to enter the 
function in the cell, Excel displays the result of the formula in the cell. 
 
If you are not sure how a particular function works, the Function Wizard 
can guide you through the process of entering a function. Activate the 
Function Wizard by clicking the Function Wizard button and follow the 
instructions given.  
 

Creating a Chart Using the ChartWizard 
A chart is a graphic representation of your worksheet data. Values from 
cells (data points) are displayed as bars, lines, column, pie slices, or other 
shapes in the chart. Data points are grouped into data series, which are 
distinguished by different colors or patterns on the chart. 
 
The ChartWizard is a series of dialog boxes that simplifies creating a 
chart. The ChartWizard guides you through the process step by step: you 
verify your data selection, select a chart type, and decide whether to add 
items such as titles and a legend. A sample of the chart you are creating is 
displayed so you can make changes before you finish working with the 
ChartWizard. 
 
The Difference Between Embedded Charts and Chart Sheets 
You can create an embedded chart as an object on a worksheet when you 
want to display a chart along with its associated data. 
 
You can create a chart sheet as a separate sheet in a workbook when you 
want to display a chart by itself on a page. The corresponding data is 
stored on a difference sheet in a workbook. Whether you create an 
embedded chart or a chart sheet, your chart data is automatically linked to 
the worksheet you created it from. When you change the data on your 
worksheet, the chart is updated to reflect these changes. 
 

Plotting a Data Series in Rows or Columns 
When you create a chart, you specify the orientation of the data – whether 
the data series are in rows or columns that are adjacent to each other. 
 

Plotting Nonadjacent Selections 
Sometimes the data you are plotting is in rows or columns separated by 
other data, or by blank rows or columns. You can make nonadjacent 
selections and use them to create a chart by: 
 
1. Selecting the cells in the first row or column. 
 

2. Hold the CTRL  (Windows) or COMMAND  (Macintosh) key down 
while you make additional selections. 

 
Changing the Chart Type 

Sometimes you may want to change the chart type to better illustrate your 
data.   
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To change the chart type: 
1. Activate the chart by clicking on the chart image.   
 

2. From the Format menu, select the Chart Type command. 
 

3. Select the type of chart you want from the palette. 
 

Adding Items to a Chart 
A simple chart cannot always convey information as clearly or completely 
as you would like. You can add information, increase visual interest, and 
enhance readability by adding elements such as data labels, titles, a 
legend, and gridlines. 
 
Adding Data Labels 
To add data labels to a data point or a data series: 
1. Select the point of the series. 
 

2. From the Insert menu, select the Data Labels command. 
 

3. In the dialog box, specify the kind of data labels you want displayed. 
 

Adding a Chart Title and Axis Titles 
If you have not selected a data point or data series before choosing the 
command, data labels are add to all points in the chart. 
 
Adding a Legend 
To add a chart title or axis titles: 
1. From the Insert menu, select the Titles command. 
 

2. Specify which titles you want to add. 
 
You can then select each title and type the text you want to appear. 
 
Adding Gridlines 
To add a legend that identifies the data series or categories in your chart: 
From the Insert menu, select the Legend command. 
 
To add gridlines, which extend from the tick marks on an axis across the 
plot area: 
1. From the Insert menu, select the Gridlines command. 
 

2. Specify which gridlines you want: major, minor, horizontal, vertical, 
or a combination. 
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Step-by-Step Instructions for In-Workshop Exercise 
 
1. Rename three sheets: Department Enrollment Figures; J Danforth 

Enrollment; J Danforth Budget 
 

2. Type in Headings on Department Enrollment Figures Sheet 
 

3. Type in Classes offered by the department 
 

4. Type in Undergrad and Grad Enrollment Figures 
 

5. Add the number of Undergrads & Grads =B6+C6 
 

6. Weight Grad Students by a factor of 3 =B6+(C6*3) 
7. Autosum the total number of students =SUM(D6:D12) 
 

8. Go to J Danforth's Enrollment Sheet 
 

9. Import and format (using Data, Sort) Danforth's student data from the 
registrar's office 

 
Downloading Your Roster from the Registrar’s Office 

 
The SDSU Class Roster Program at: http://www.anr.sdsu.edu/roster.shtml  
allows Faculty and certain Staff to receive class rosters via e-mail. This  
service is provided by Admissions and Records for the SDSU campus. To 
use this service, you need an E-mail address and a WWW browser. First  
Time users must register to use the SDSU Class Roster service. Registered 
faculty can only request rosters for classes in which they are the formal 
instructor.   

  
� To “import” this roster into Excel, request that your roster be sent in  

ASCII text , and the file be tab delimited. The Registrar’s Office will e-
mail you a copy of your class roster. The file will come as an attachment. 
For the purposes of this workshop, we have created a “mock” file 
(jdanforth.23908) of this attachment to work with on your floppy disk. 
1. Start Microsoft Excel. 
2. Choose File, Open. 
3. Open the file on your floppy disk, jdanforth.23908. 
 
The following “Text Import Wizard” dialog box will appear. 
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Text Import Wizard Box 

 
 
 

1. Choose Delimited. 
 

2. Choose Start import at row , Enter 13. 
 

3. Choose Next. 
 
4. Be sure that the Tab box is checked under Delimeters. 
 

5. Choose Next. 
 

6. In the "Data Preview" window, use the right scroll down button until 
you see columns of data.  

 

7. Select Columns 3, 4, 5, 6, and 7. Note that an easy way to select all 5 
of these columns at the same time is to press the Shift key while 
Clicking on each column. This will allow you to select more than one 
column at a time. 

 

8. Under general Data Format, Select Do Not Import Column (Skip). 
 

9. Choose Finish. 
 

You want to 
“Start 
Importing” 
where your 
“usable” 
data starts.  
In our case, 
this is at 
row “13.” 

Be sure to 
check the 
“Delimited” 
box. 
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Formatting your Imported Data 
 
When your roster data is brought into Excel, it is unformatted. Begin by 
formatting the imported data. 
1. Delete the rows of data, which are unnecessary to your grade sheet. 

These rows include data such as "letter" and "+/- letter." 
 

2. Select these rows simultaneously on a Mac, by holding the ; key when 
you click. On Windows, hold down the Ctrl  key when you click. 

 

3. Once the rows have been selected, choose Edit  and then Delete. Or on 
a Mac, use ;+K . On Windows, use Ctrl+X . 

 
Format the width of your columns to fit the name & social security 
number. 
1. Click the column heading to select the entire column. To select both 

columns, press the Shift key, while clicking both columns or, click on 
column A, then while holding your mouse button down, slide your 
cursor to column B. 

 

2. Position the mouse pointer on the right border  of the heading of the 
columns. The mouse pointer changes to a double-headed horizontal 
arrow  when positioned properly. Drag the arrow to the right  to 
increase the column with.   

 
 Note that you can tell Excel to make the column width exactly large 

enough for the largest piece of data in the column, by double clicking at 
the double-headed arrow. 
 
 

3. Count the total number of students =COUNT(C6:C35) 
 

4. Count the total number of Undergraduate Students 
=COUNTIF(C6:C35,"<5") 

 

5. Count the total number of Grad Students =COUNTIF(C6:C35,"5") 
 

6. Link the Undergraduate and Grad enrollments in Danforth's Class to 
the appropriate box on the Department Enrollment Figures Sheet 

 

7. On Department Enrollment Figures Sheet Divide the department 
allocation ($5000) by the total number of students (1000) = D15/D13 

 

8. Figure out the individual class allocations of department funds by 
multiplying the total number of students in a class by the student 
allocation ($5.00) D4*$D$16 - make absolute before filling. 

 

9. Take Danforth's allocation ($200) and use it as the beginning 
"checkbook" balance on the J Danforth Budget Sheet 

 

10. Enter in the Headings, Dates, Descriptions and Expenses on J 
Danforth's Budget Sheet 

 

11. Enter the formula which will keep the running balance =E6-D7 

Step #8 begins 
here. 
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12. Calculate the average count expense using the function wizard 
=AVERAGE(D7:D14) 

 

13. Total Danforth's Expenses using the Sum Function =SUMD7:D14 
 

14. Enter the total expenses for each class, with Danforth's being $175. 
 

15. Create a chart using three columns of data: Class, Allocation, and 
Expense. 

 
Congratulations!   

You have completed the Microsoft Excel Intermediate Workshop for 
Faculty and Staff at SDSU. Please feel free to contact your instructor if 
you have any questions on material covered during this workshop. Also, 
please feel free to take advantage of the help resources listed at the 
beginning of this handout. 
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Shortcut Keys – Windows 
 

Ctrl + N Opens a new file 
Ctrl + O Opens an existing file 
Ctrl + S Saves a file 
Ctrl + P Prints the active document 
Ctrl + F4 Exits the application 
Ctrl + Z Undoes last action 
Ctrl + X Cuts the selection 
Ctrl + C Copies the selection to the Clipboard 
Ctrl + V Pastes a selection from the Clipboard 
Ctrl + B Bold on/off 
Ctrl + I Italics on/off 
Ctrl + Shift + W Underline 
 

 
Shortcut Keys – Mac 

 

Command + N Opens a new file 
Command + O Opens an existing file 
Command + S Saves a file 
Command + P Prints the active document 
Command + Q Exists the application 
Command + Z Undoes last action 
Command + X Cuts the selection 
Command + C Copies the selection to the Clipboard 
Command + V Pastes a selection from the Clipboard 
Command + B Bold on/off 
Command + I Italics on/off 
Command + U Underline 
 


